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About This Manual

This manual serves as an instruction manual for the Experion™ RNA StdSens starter kit.
General instructions for using the Experion system and the RNA StdSens analysis kit, can
be found in the following:

• The Experion RNA StdSens analysis kit instruction manual (bulletin 10000976)

• The Experion system instruction manual (bulletin 10001312)

In addition, a number of tech notes, product information sheets, and flyers provide more
details about the features and applications of the Experion system. For a complete, up-to-date
list of all Experion literature, visit www.bio-rad.com/experion/

Bio-Rad Technical Support 
The Bio-Rad technical support department in the United States is open Monday–Friday,
7:00 AM–5:00 PM, Pacific Time.

Phone: 1-800-4BIORAD (1-800-424-6723)

Fax: (510) 741-5802 

E-mail: LSG_TechServ_US@bio-rad.com (for US and international customers)
Online technical support and worldwide contact information are available on the Web at
www.consult.bio-rad.com

Notices
No part of this publication may be reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopy, recording, or any information storage or retrieval system, without 
permission in writing from Bio-Rad Laboratories, Inc.

Bio-Rad reserves the right to modify its products and services at any time. This user guide is subject to
change without notice.

Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors, or for any damages
resulting from the application or use of this information.

Microsoft and Excel are trademarks of Microsoft Corporation. RiboGreen is a trademark of Molecular
Probes, Inc. VWR is a trademark of VWR International, Inc.

LabChip and the LabChip logo are trademarks of Caliper Life Sciences, Inc.
Bio-Rad Laboratories, Inc. is licensed by Caliper Life Sciences, Inc. to sell 
products using the LabChip technology for research use only. These products
are licensed under U.S. patents 5,863,753, 5,658,751, 5,436,134, and 5,582,977,
and pending patent applications, and related foreign patents, for internal
research and development use only in detecting, quantitating, and sizing 
macromolecules, in combination with microfluidics, where internal research and
development use expressly excludes the use of this product for providing 
medical, diagnostic, or any other testing, analysis, or screening services, or 
providing clinical information or clinical analysis, in any event in return for 
compensation by an unrelated party.

Copyright © 2008 by Bio-Rad Laboratories. All rights reserved.
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Introduction — Product Description and Components

The Experion™ System and RNA StdSens Starter Kit
The Experion automated electrophoresis system employs LabChip microfluidic technology
to automate protein and nucleic acid electrophoresis and analysis. This system integrates
separation, detection, and data analysis within a single platform, using smaller sample and
reagent quantities than standard analysis methods. The Experion system accomplishes
analysis in a single 30 minute, automated step.

The Experion electrophoresis system includes the following components:

• Automated electrophoresis station
• Microfluidic chips 
• Priming station 
• Vortex station (for RNA and DNA analyses only)
• Reagents (analysis kits and individual components)
• Experion software

The Experion system includes the following components: 1) automated electrophoresis station, 
2) priming station, 3) vortex station used for nucleic acid analysis only, 4) system operation and data
analysis tools, and 5) analysis kits, which include the (a) chips and (b) reagents for protein (Pro260 kit), 
standard-sensitivity RNA (StdSens kit), high-sensitivity RNA (HighSens kit), and DNA (DNA 1K and 12K kits)
analyses.

At the center of the Experion system is the microfluidic chip, which contains a series of
plastic wells bonded over a small glass plate. The glass plate is etched with an optimized
network of microchannels, which connect with the base of the plastic wells. The channels
are primed with a gel matrix, the samples are applied to the appropriate wells, and the
electrophoresis station directs the samples through these microchannels by controlling the
voltages and currents that are applied. The microfluidic chip, in conjunction with the
Experion reagents, electrophoresis station, and software accomplish separation, staining,
destaining, detection, and basic data analysis without any user intervention.

1
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The Experion RNA StdSens starter kit was designed to introduce new users to RNA analysis
with the Experion system as well as to enable troubleshooting, performance maintenance,
or performance qualification of the Experion system. The starter kit is derived from the
Experion RNA StdSens analysis kit, which is used with the Experion system to determine
total RNA and mRNA integrity, purity, and concentration at nanogram levels. A second
RNA analysis kit (the Experion RNA HighSens analysis kit) is used for analysis at
picogram levels. All kits include the Experion RNA ladder, which has been optimized for 
automated electrophoresis on the Experion system. They also feature the Experion RNA
loading buffer, which contains a 50 bp marker that is used for the proper alignment of 
samples to the RNA ladder. The starter kit contains the same components as the Experion
RNA StdSens analysis kit in addition to other supplies that allow a new user to start using
the system immediately.

RNA analysis with the Experion system compares favorably with other, more conventional
methods for RNA quantitation, such as UV spectroscopy, with regards to assay linearity,
reproducibility, and accuracy. However, in contrast with UV spectroscopy, Experion analysis
is relatively unaffected by reagents common to RNA preparation. The additional microfluidic
separation step also affords the unique ability to visually evaluate the RNA sample for
degradation and for the presence of copurifying nucleic acids, such as genomic DNA and
tRNA (Woo and Strong 2006)1.

For more information on RNA analysis using the Experion system, refer to Appendix A of
this manual.

Detection and Quantitation Ranges of the Experion RNA Analysis Kits

RNA StdSens Analysis Kit RNA HighSens Analysis Kit

Total RNA mRNA Total RNA mRNA

Detection range 5–500 ng/µl 25–250 ng/µl 100–5,000 pg/µl 500–5,000 pg/µl

Quantitation range 25–500 ng/µl 25–250 ng/µl 200–5,000 pg/µl 500–1,000 pg/µl

1 Woo L and Strong W, RNA quantitation: A comparative analysis using the Experion automated electrophoresis system,

RiboGreen reagent, and ultraviolet spectroscopy, Bio-Rad bulletin 5420 (2006)

2
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Kit Components and Storage Conditions
Experion RNA StdSens Starter Kit Components and Storage Conditions

Component Storage Conditions

Experion RNA StdSens chips, 3 Ambient

Reagents for analysis

RNA gel, 1 vial, 1,250 µl 4°C

RNA loading buffer, 1 vial, 900 µl 4°C

RNA stain, 1 vial, 20 µl 4°C

Spin filters, 1 4°C

RNA ladder, 1 vial, 20 µl –70°C

Mouse liver total RNA sample (500 ng/µl), 20 µl –70°C

DEPC-treated water, 50 ml Ambient

Experion electrode cleaner, 25 ml Ambient

Experion cleaning chips, 2 Ambient

Foam swabs, 25 Ambient

Narrow-bore 20 µl pipet tips, RNase-free, 96 (1 rack) Ambient

0.65 ml microcentrifuge tubes, RNase-free, 50 Ambient

Experion Training Video: Chip Loading (DVD) Ambient

Instructions Ambient

Additional Materials and Equipment Required

• Experion automated electrophoresis station
• Experion priming station
• Experion vortex station
• Microcentrifuge (1,000–10,000 x g)
• Aluminum foil
• Heating block or water bath set at 70°C
• Benchtop vortexer
• Extra spin filter for additional filtration steps (optional, catalog #700-7254)
• Ice

The Experion RNA StdSens Starter Kit Tests

The Experion RNA StdSens starter kit includes all the reagents, consumables, and 
instructions required to perform two tests that demonstrate the performance of the
Experion system for RNA analysis. Each test uses various dilutions and preparations of a
mouse liver total RNA sample, and each test follows the standard Experion RNA StdSens
assay workflow, which is summarized below.

3
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Experion RNA StdSens Starter Kit Tests

Test Name Purpose Description

1 RNA analysis basics Used for familiarization Run an Experion RNA StdSens 
with the Experion system analysis of 12 replicates of a total RNA 
and for troubleshooting. sample (100 ng/µl), check the resulting
Demonstrates the basic electropherograms for performance, 
features, functions, and and determine the reproducibility of
reproducibility of an quantitation
Experion RNA StdSens
assay

2 Quantitation across a Used for demonstration of Prepare a dilution series of the total
range of the quantitative dynamic RNA sample (25–500 ng/µl) and use
concentrations range of the Experion RNA this series to analyze the reproducibility

StdSens assay. of quantitation across the quantitative
range

Before running any of the tests:

• Watch the Experion Training Video: Chip Loading (supplied with this kit and available
at www.bio-rad.com/experion/)

• Clean the electrodes as detailed in Appendix B. When working with RNA, pay special
attention to cleaning the Experion system to ensure the electrodes remain free from
RNases. This is particularly true if one system serves many users within a laboratory

Note: If this is the first time the Experion electrophoresis station is being used, refer to
Appendix C for instructions on how to prepare the system for use.

4
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Experion RNA StdSens Starter Kit Test Workflow

Equilibrate the reagents

Filter the gel and prepare the gel-stain solution

Prepare the samples and the RNA ladder

Prime the chip

Load the chip

Perform the run within 5 minutes of chip loading and analyze the data

Set up the electrophoresis station and clean the electrodes

5
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Starter Kit Test 1 — RNA Analysis Basics

1.1  Overview of Test 1

Microfluidic chips use much smaller amounts and volumes of samples and reagents than
traditional slab gels. As a result, microfluidic separations are much more sensitive to 
variability in pipetting technique when compared to traditional electrophoresis methods.
Proper pipetting skills and tools are critical to a successful Experion™ analysis.

In this test, you run an Experion RNA StdSens analysis of a single concentration of the
total RNA sample, check the resulting electropherograms for proper performance, examine
quantitation results, and export the data to determine the reproducibility of the analysis.

Since the use of proper pipet tips can also impact assay performance, use the narrow-bore,
RNase-free pipet tips included with the Experion RNA StdSens starter kit (or similar 
narrow-bore tips) for loading samples and reagents into the microfluidic chip. Narrow-bore
tips are required for successful chip loading (other tips can introduce bubbles during chip
loading, leading to problems in performing the assay or in the quality of results).

1.2  Assay Procedure 

1.2.1  Set Up the Electrophoresis Station and Clean the Electrodes

Note: If this is the first time the Experion electrophoresis station is being used, refer to
Appendix C for instructions on how to prepare the system for use.

1. Power on the computer.

2. Power on the Experion electrophoresis station. Push the green button in the center of
the front panel. The steady green LED above the button indicates that the unit is on.

3. Launch Experion software. Check the screen to confirm that the instrument and 
computer are communicating properly.
When communication has been established:
• A green dot with the last four digits of the instrument serial number appears in

the lower right corner of the main software screen
• The electrophoresis station icon appears in the upper left corner 

When there is no connection, these indicators are absent and a “disconnected”
message appears next to the Start Run button in the upper left corner of the
screen. In addition, a grayed-out instrument icon appears in the upper left corner of the
software screen.

4. Clean the electrodes as described in Appendix B.

1.2.2  Equilibrate the Kit Reagents

1. Set a heating block or water bath to 70°C. You will use this heating block to denature
the samples and the RNA ladder later in the protocol.

2. Remove the kit components from storage.

• Thaw the following kit components on ice (~15–20 min):

– Total RNA sample 

– RNA ladder

• Equilibrate the following kit components to room temperature (~15–20 min):

– RNA stain (blue cap) 
6
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– RNA loading buffer (yellow cap)

– RNA gel (green cap)2

Notes: Experion RNA stain (blue cap) is light-sensitive and contains DMSO, which is highly
hygroscopic. Cap the tube of stain tightly and keep it covered (for example, with foil) at all
times to avoid exposure to light.

Inspect the reagents prior to thawing: if the RNA gel (green cap) has been frozen, do not
use it.

Do not store reagents at room temperature for more than 2 hr, as this will affect their shelf
life.

3. Vortex the contents of each tube and briefly centrifuge to collect the solutions to the
bottoms of the tubes. Make sure that the RNA stain solution (blue cap) is completely
thawed before proceeding.

4. Prepare 3 µl aliquots of the RNA ladder in RNase-free microcentrifuge tubes. Freeze
all aliquots except the one you will be using at –80°C. This ensures integrity of the
RNA ladder, a critical component of the RNA StdSens assay.

1.2.3  Filter the Gel and Prepare the Gel-Stain Solution

Notes: The Experion RNA StdSens starter kit includes 1 spin filter, which is sufficient for
one preparation of filtered gel (G). You will also use the prepared G in Test 2. The prepared
G can be used for up to 4 weeks when stored in the dark at 4°C between each use. The
gel can be refiltered once after that to extend its use for another 4 weeks.

Additional spin filter tubes and reagents may also be purchased separately (see Appendix
D for ordering information).

This protocol generates enough GS for 3 chips. Increase the amount, if required, by using
a 65:1 ratio of gel and stain. Prepare fresh GS daily.

1. Filter the gel. Pipet 600 µl RNA gel (green cap) into a spin filter and label the tube with
“G” and the date. Centrifuge at 1,500 x g for 10 min. Confirm that all of the gel has
passed through the filter and then discard the filter.

2. Prepare the GS. Pipet 65 µl filtered gel into an RNase-free 0.65 ml microcentrifuge
tube and label the tube “GS”. Add 1 µl RNA stain and vortex. Keep the GS protected
from light.

1.2.4  Prepare the Samples and RNA Ladder 

1. Once the total RNA sample and RNA ladder have thawed, vortex the tubes briefly and
spin down for a few sec. The concentration of the stock total RNA preparation is 
500 ng/µl.

2. Denature the RNA sample and the RNA ladder. Transfer 4 µl total RNA sample and 
3 µl RNA ladder to separate 0.65 ml RNase-free microcentrifuge tubes labeled “S1”
and “L”, respectively. Heat the tubes at 70°C for 2 min, and place them on ice 
immediately after heating. Vortex briefly and spin down. Keep the tubes on ice.

3. Generate the 100 ng/µl sample used in this test by adding 16 µl DEPC-treated water
to the sample tube (S1).

4. Vortex to mix the tubes, and spin down.

2 If the filtered gel (G) was prepared previously, remove it from storage and equilibrate it to room temperature.

7
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1.2.5  Prime the Chip

Before priming the chip, ensure that all samples, the RNA ladder, and other reagents are
prepared and ready to be loaded. If a chip is not used within 5 min of priming and loading,
reagents may evaporate, leading to poor results. Use the narrow-bore pipet tips that are
supplied with the kit (or equivalent tips) when loading samples or reagents into the chip.

1. Pipet 9 µl GS into the well labeled GS (gel priming well) (Figure 1.1). Insert the pipet tip
vertically and to the bottom of the well when dispensing. Dispense slowly, and do not
expel air at the end of the pipetting step.

Note: Placing the pipet tip at the edge of the well or allowing the gel to slide down the wall
of the well may lead to bubble formation at the bottom of the well. Remove any bubbles at
the bottom of the well by removing the GS and loading a new aliquot. For help with chip
loading, refer to the Experion Training Video: Chip Loading.

Fig. 1.1. Experion RNA StdSens chip. The locations of the gel priming well (GS) and alphanumeric
priming code are indicated.

2. Set the pressure setting to B and the time setting to 1, as specified by the alphanumeric
code on the chip (Figure 1.1).

3. Open the Experion priming station by pressing down on the lever on the front.

4. Place the chip on the chip platform, matching the arrow on the chip with the alignment
arrow on the chip platform. A post on the chip prevents insertion in the wrong position.
Do not force the chip into position.

5. Carefully close the priming station by pressing down on the lid. The lid should snap
closed.

6. Press the Start button. A “Priming” message appears on the screen of the priming
station, the priming station pressurizes, and the timer begins to count down. Priming
requires approximately 30 sec to complete. Do not open the priming station during the
countdown.

7. An audible signal and “Ready” message indicate that priming is complete. Open the
priming station by pressing down on the release lever.

Note: If the lid sticks, press down on it while pressing down on the release lever.

8
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8. Remove the chip from the priming station, turn it over, and inspect the microchannels
for bubbles or evidence of incomplete priming. If the chip is primed properly, the
microchannels are difficult to see (it may be helpful to compare a primed chip to a
new, unused chip). If you detect a problem, such as a bubble or incomplete priming,
prime a new chip.

9. Place the chip on a clean surface for loading.

1.2.6  Load the Chip

1. Pipet 9 µl GS into the other well labeled GS (NOT the gel priming well) (Figures 1.1
and 1.2).

2. Pipet 9 µl filtered gel into the well labeled G (Figures 1.1 and 1.2).

3. Pipet 5 µl loading buffer (yellow cap) into each sample well (1–12) and into the ladder
well (L).

Note: Use a new pipet tip for each delivery to prevent contamination of the loading
buffer stock. Alternatively, remove 70 µl of loading buffer into an RNase-free tube and
pipet 5 µl to each well from this volume.

4. Pipet 1 µl denatured RNA ladder into the well labeled L. Every chip must have the
RNA ladder loaded into the ladder well labeled L.

5. Pipet 1 µl sample into each of the sample wells (1–12). Every sample well (1–12)
must contain solution.

Fig. 1.2. Chip layout for Experion RNA StdSens starter kit Test 1. S1, sample; GS, gel-stain solution;
G, RNA gel; L, RNA ladder.

6. Inspect all wells to make sure that there is no excessive bubble formation from pipetting.
Hold the chip above a light background and look down through the wells (Figure 1.3).
Dislodge any bubbles at the bottom of the well with a clean pipet tip or by removing
and reloading the solution.

S1 S1 S1 G 

S1 S1 S1 GS 

S1 S1 S1 GS 

S1 S1 S1 L 
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Fig. 1.3. Bubble formation during loading of Experion Pro260 chips. Left, example of bubbles
trapped at the bottom of wells. The GS and G wells and sample wells 1, 3, and 4–6 contain no solution.
Well 10 is filled properly and has no bubbles; large bubbles have formed at the bottom of wells 8 and 9
and in the ladder well (L). Note the difference in the diameter of the light-colored circles in wells 10 and
L. Right, example of bubble formation at the surface of wells. Small bubbles have formed at the surface
of the three GS wells on the right side of the chip, and the rest of the wells have no bubbles. Surface
bubbles should not cause problems during a run, but bubbles at the bottoms of wells must be removed.

7. Place the chip in the Experion vortex station. Turn on the vortexer, which operates for
60 sec and then automatically shuts off. Remove the chip when the vortexer stops.

8. Place the loaded chip into the Experion electrophoresis station and start the run. Run
a loaded chip immediately (within 5 min) or excess evaporation may occur, leading to
poor results or a chip performance error.

1.2.7  Run the RNA StdSens Analysis

1. Open the lid of the electrophoresis station by pulling the release latch. Place the
primed and loaded chip on the chip platform and close the lid.

2. In the Experion software toolbar, click the New Run button . The New Run
screen opens (Figure 1.4).

10
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Fig. 1.4. Details of the New Run screen. The green dot in the lower right hand corner indicates that
communication between the electrophoresis station and Experion software has been established.

3. From the Assay drop-down list, select StdSens > Eukaryotic total RNA.

4. Select a project folder for the run from the Project drop-down list.

- Or - 

Create a new project folder by typing a name in the Project field or by selecting 
File > Project > New.

The project folder appears in the project tree after the run has started.

5. Enter a name for the run in the Run Prefix field.

6. Click the Start Run button at the top of the window to start the run. The New Run
dialog opens (Figure 1.5).

11
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Fig. 1.5. New Run dialog. The Experion system stops analysis when it reaches the number of samples
entered.

7. Select the number of samples to be analyzed (12 for both tests).

8. Click Start to begin the run. The green LED in the center of the front panel on the
electrophoresis station blinks once the run has started.

Warning: Do not open the lid of the Experion electrophoresis station until the run is 
complete. The lid does not lock. Opening the lid prematurely aborts the run.

The system performs a number of checks at the beginning of a run: it confirms that a chip
has been inserted, that all wells contain liquid, that electrical connections are made, etc. A
calibration counter marks the progress of these calibrations in the upper right corner of the
screen.

Note: An “IV Check Error” message indicates the system cannot make electrical contact in
one or more of the wells. This often means that either there is a bubble in a well or that a
well is empty. If this message appears, abort the run and check the chip for bubbles or
empty well(s). Refill the affected well(s), and start the run again.

9. Enter the sample names under Sample Information. For example, enter “S1”. In 
addition, add sample details, such as sample concentration. Alternatively, enter this
information when the run is complete using the Run Info tab.

10. During separation, the sample name is highlighted in gray in the project tree and the
electropherogram trace and virtual gel bands appear in real time. By default, the 
electropherogram of the sample being separated appears in the electropherogram
view; in the gel view, the lane corresponding to that sample is outlined in pink and has
a dark background. To display the electropherogram from another sample that has
already been separated, click on either the sample name in the project tree or on a
lane in the virtual gel.

11. When analysis is complete (after approximately 30 min), the instrument beeps and a
window opens indicating the end of the run. Select OK to the prompt and remove the
chip from the chip platform.

12. Clean the electrodes using DEPC-treated water. Add 800 µl DEPC-treated water to a
cleaning chip, and insert the cleaning chip into the electrophoresis station for 1 min.
Remove the chip and allow the electrodes to dry for 1 min before closing the lid. See
Appendix B for more details.

13. Analyze the run and the data.

12
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1.3  Data Analysis

Evaluate the performance of Test 1 and the analysis of the data by Experion software.

1. Evaluate the virtual gel to ensure that all lanes (samples) are visible. Check that the
lower marker is present in each sample (indicated by pink triangles) and that it is
aligned across all lanes (Figure 1.6).

2. Modify the gel view by changing the fluorescence intensity scale. By default, Experion
software displays the virtual gel and electropherograms as “scaled to local”, which
means the gel lane or trace of each sample is scaled to the highest peak intensity
detected in that sample. This is the best method for viewing an electropherogram.
To adjust the fluorescence intensity scale so that the virtual gel most closely resembles
a gel-based separation, select Graph > Scale to Global. The virtual gel appears as it
does in Figure 1.6, right panel. All lanes are scaled to the highest peak found across
the entire chip, which enables comparison of the concentration differences among the
samples in the virtual gel

Fig. 1.6. Virtual gel generated by Test 1. Left, virtual gel “scaled to local”. Right, virtual gel “scaled to
global”. L, RNA ladder; lanes 1–12, 100 ng/µl total RNA sample.
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3. Evaluate the separation of the RNA ladder (Figure 1.7). This is a critical step in data
analysis because much of the automated data analysis performed by Experion software
is based on the successful separation of the RNA ladder. To display the ladder 
electropherogram, click the ladder well in the project tree, or click on the lane labeled L
in the virtual gel. The electropherogram should resemble the one shown below and
should have the following features:

• A lower marker peak at ~21 sec followed by a set of 8 well-resolved RNA ladder
peaks 

• Flat baseline

• Marker peak at least 5 fluorescence units above the baseline

Fig. 1.7. Separation of the RNA ladder (scaled to local). Note the flat baseline and well-resolved
peaks. Fragment sizes are given in nucleotides.
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4. Examine the separation of the total RNA sample. Click on the sample name in the 
project tree or on a lane in the virtual gel. The electropherogram appears and should
have the following features (Figure 1.8):

• A lower marker peak at ~21 sec, at least 5 fluorescence units above the baseline,
and distinguishable from the sample peaks

• Flat baseline

• Well-resolved 18S and 28S rRNA peaks

Fig. 1.8. Separation of the 100 ng/µl mouse liver total RNA sample (scaled to local). Results shown
are typical for separations of total RNA from eukaryotic sources. The two most prominent peaks, aside
from the lower alignment marker, represent 18S and 28S ribosomal RNA (rRNA).

5. Evaluate the data analysis performed by Experion software. Click on the Results tab
and click on lane 2 in the virtual gel. The Results table for sample 2 opens (Figure 1.9).
View the RNA concentration given in the Results table. In the example in Figure 1.9,
the total concentration of the sample is 112.14 ng/µl.

15
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Fig. 1.9. Results table generated for well 2 in Test 1.

6. To perform a qualitative evaluation of quantitation reproducibility, overlay the 
electropherograms of replicate samples. For example, in the virtual gel, select lane 1
and hold the Shift key while selecting lane 12. The electropherograms from all 12 wells
overlap (Figure 1.10). Tighter overlaps signify better reproducibility.

Fig. 1.10. Electropherogram overlay showing the overlay of all 12 of the 100 ng/µl samples.

7. Evaluate the reproducibility of quantitation by calculating the coefficient of variation
(%CV), which is defined as the standard deviation/mean x 100. To do this, export the
data to a Microsoft Excel or other spreadsheet application either by entering the RNA
concentration values manually or by using the data export feature of Experion software.
Reproducibility is most strongly influenced by pipetting technique (the ability to 
reproducibly pipet 1 µl sample and 5 µl loading buffer into each well).

8. To use the export feature of Experion software, select File > Export Data... The Export
dialog opens. Select Result Table and Format as Single Table and then click Export.
In the Save As window, name the file and designate a folder for it. Click Save.

9. Launch Excel software and select File > Open. Change Files of type to All, locate the
text file exported in step 8, and select Open. The Import wizard opens. Click Finish.

16
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10. The data appear in the spreadsheet. Click on cell H1 (Peak Number) and select 
Data > Sort to sort the data by peak number.

11. Insert 3 columns between columns I and J, and label them Mean Conc, Stdev, and
%CV, respectively. Use Excel software to determine the mean, standard deviation, and
%CV for samples 1–12 (Figure 1.11). The %CV for Test 1 using the mouse liver total
RNA sample provided is typically £15%

Fig. 1.11. Excel spreadsheet showing example of calculation of mean, standard deviation, and
%CV.

Expected Performance of Test 13. Based on results obtained using 72 samples at 100 ng/µl.

Measurement Typical Results

Quantitation reproducibility %CV £ 15% for 100 ng/µl total RNA

Quantitation of RNA samples with the Experion system offers reproducibility and accuracy that
are comparable to other traditional methods, such as UV spectroscopy. It also offers a level of
sensitivity that is similar to that offered by fluorescent probes, such as the RiboGreen reagent
(Woo and Strong 2006)3.

If your results do not appear as they do in these examples, refer to the Troubleshooting section
of the Experion RNA analysis kit and Experion system instruction manuals or contact Bio-Rad
technical support. Typically, problems with reproducibility are due to problems with pipetting or
chip loading. For tips on optimizing your results, refer to the Experion Training Video: Chip
Loading and the Essential Practices and Troubleshooting sections of the Experion system
instruction manual.

3 For more detailed analyses of the expected performance of the Experion RNA StdSens assay, refer to the following 
Bio-Rad tech notes:

Urban et al., Performance comparison of the Experion automated electrophoresis system and a competing automated
system for RNA analysis, Bio-Rad bulletin 5286 (2005) 

Woo L and Strong W, RNA Quantitation: A comparative analysis using the Experion automated electrophoresis system,
RiboGreen reagent, and ultraviolet spectroscopy, Bio-Rad bulletin 5420 (2006)
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Starter Kit Test 2 — Quantitation Across a Range of
Concentrations

2.1  Overview of Test 2
In this test, you analyze a dilution series of the total RNA sample to examine the 
reproducibility of quantitation across the entire quantitation range of the Experion™ RNA
StdSens analysis kit (25–500 ng/µl).

Note: The quantitative range of the Experion RNA StdSens analysis kit is different from its
detection range: whereas the detection range of the assay for total RNA is 5–500 ng/µl, the
quantitative range is 25–500 ng/µl (at the lower end of the quantitative range, the 
signal-to-noise ratio is lower). Though RNA detection and purity analysis can be performed
at concentrations of less than 25 ng/µl using the StdSens assay, quantitation at these low
concentrations is not recommended since RNA concentrations of <25 ng/µl are outside the
linear range of detection. For quantitation of samples containing 0.1–5 ng/µl RNA, use the
Experion RNA HighSens analysis kit.

2.2  Assay Procedure
1. Set up the electrophoresis station, clean the electrodes, thaw and equilibrate the

reagents, and prepare the gel (G) and gel-stain solution (GS) as outlined in Sections
1.2.1–1.2.3. If the G has already been prepared, equilibrate it as detailed in Section
1.2.2.

2. Denature the total RNA sample and RNA ladder as described in Section 1.2.4, steps
1–2, using 3 µl RNA ladder and 7 µl total RNA sample (stock preparation). Label the
total RNA sample “S1”.

3. This test uses a dilution series of the total RNA sample. Label 3 microcentrifuge tubes
(S1–S3) and prepare the following dilutions:

Tube S1 (500 ng/µl): No additions; this is the stock preparation you denatured

Tube S2 (100 ng/µl): 8 µl DEPC-treated water + 2 µl total RNA from tube S1

Tube S3 (25 ng/µl): 6 µl DEPC-treated water + 2 µl total RNA from tube S2

4. Vortex to mix the tubes, and spin down.

5. Prime and load the chip as described in Sections 1.2.5 and 1.2.6 and using the chip
layout shown in Figure 2.1.

S3 S2 S1 G

S3 S2 S1 GS

S3 S2 S1 GS

S3 S2 S1 L

Fig. 2.1. Chip layout for Experion RNA StdSens starter kit Test 2. S1–S3, sample numbers; GS, gel-
stain solution; G, RNA gel; L, RNA ladder.

6. Run the RNA StdSens analysis as described in Section 1.2.7. Enter the sample names
and information appropriate to the chip layout in Figure 2.1.
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2.3  Data Analysis
Evaluate the run and the analysis of the data by Experion software.

1. Evaluate the virtual gel to ensure that all lanes (samples) are visible. Check that the
lower marker is present in each sample (indicated by pink triangles) and that it is
aligned across all lanes (Figure 2.2).

2. Select Graph > Scale to Global to adjust the fluorescence intensity scale so that the
virtual gel most closely resembles a gel-based separation (Figure 2.2). All lanes are
scaled to the highest peak found across the entire chip, which enables comparison of
the concentration differences among the samples in the virtual gel.

Fig. 2.2. Virtual gel generated by Test 2. L, RNA ladder; lanes 1, 4, 7, and 10, 25 ng/µl total RNA;
lanes 2, 5, 8, and 11, 100 ng/µl total RNA; lanes 3, 6, 9, and 12, 500 ng/µl total RNA. In this example, the
virtual gel was “scaled to global” to emphasize the differences in sample concentrations.

3. Evaluate the separation of the RNA ladder. This is a critical step in data analysis
because much of the automated data analysis performed by Experion software is
based on the successful separation of the RNA ladder. To display the ladder 
electropherogram, click the ladder well in the project tree, or click on the lane labeled L
in the virtual gel. The electropherogram should resemble the one shown in Figure 1.7.

4. Examine the separation of one of the total RNA samples. Click on a sample name in
the project tree or on a lane in the virtual gel. The electropherogram appears and
should have the features described for Figure 1.8 (a lower marker peak at ~21 sec that
is at least 5 fluorescence units above the baseline and distinguishable from the sample
peak, a flat baseline, and well-resolved 18S and 28S rRNA peaks).
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5. Evaluate the data analysis performed by Experion software. Click on the Results tab
and view the RNA concentrations given for each sample in the Results table. See Test 1
for an example.

6. To perform a qualitative evaluation of quantitation reproducibility, overlay the 
electropherograms of replicate samples. For example, in the virtual gel, select lane 3
and hold the Ctrl key while select lanes 6, 9 and 12. The electropherograms from wells
3, 6, 9 and 12 (500 ng/µl samples) overlap (Figure 2.3). Repeat for the other 
concentrations. Tighter overlaps signify better reproducibility.

Fig. 2.3. Electropherogram overlay of the 500 ng/µl samples.

7. To perform a quantitative evaluation of reproducibility, calculate the coefficient of variation
(%CV), which is defined as the standard deviation/mean x 100. To do this, export the data
to a Microsoft Excel or other spreadsheet application either by entering the values 
manually in Excel or by using the data export feature of Experion software as described
in Test 1. The data appear in the spreadsheet after sorting by peak number (Figure 2.4).
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Fig. 2.4. Excel spreadsheet showing Test 2 data sorted by peak number.

8. Insert a column between columns H and I, and label it Exp Conc (Expected
Concentration). Enter the expected concentration for each well.

9. Click on cell I1 (Exp Conc) and select Data > Sort to sort the data by expected 
concentration (Figure 2.5).

Fig. 2.5. Excel spreadsheet showing Test 2 data sorted by expected concentration.

10. Insert 3 columns after column J, and label them Mean Conc, Stdev, and %CV. Use
Excel software to determine the mean, standard deviation, and %CV for each set of 
replicates (each concentration examined) (Figure 2.6).

Fig. 2.6. Excel spreadsheet showing example of calculation of mean, standard deviation, and %CV.
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11. Plot the results as a function of sample concentration (Figure 2.7). The overall trend
should be linear.

Fig. 2.7. Plot of concentration calculated by Experion software as a function of expected 
concentration.

Expected Performance of Test 2. Based on results obtained using a total of 6 chips.

Measurement Typical Results

Quantitation reproducibility %CV £ 20% for total RNA (25–500 ng/µl)

If your results do not appear as they do in these examples, refer to the Troubleshooting 
section of the Experion RNA StdSens and Experion system instruction manuals or contact
Bio-Rad technical support. Typically, problems with reproducibility are due to problems with
pipetting or chip loading. For tips on optimizing your results, refer to the Experion Training
Video: Chip Loading and the Essential Practices and Troubleshooting sections of the
Experion system instruction manual.
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Appendix A — How the Experion™ System Works 
The Experion electrophoresis system performs electrophoresis of samples within a microfluidic
chip. Within each chip, a series of microchannels connects the sample wells to a separation
channel and buffer wells. A set of electrodes in the electrophoresis station applies a voltage
across the microchannels, causing charged molecules in the samples to migrate into and
through the separation channel. Samples are run sequentially, with a sufficient lag between
them to prevent cross-contamination. For separation, the microchannels are filled with a
proprietary gel-stain solution (GS) that acts as a sieving matrix; therefore, the sample 
fragments migrate through the separation channel at a rate based on their size and charge.
Finally, sample fragments interact with a fluorescent dye during separation and are detected
as they pass by a laser and photodiode detector.

RNA analysis is accomplished with the Experion RNA analysis kits. Two RNA analysis kits
are available, and they differ in the level of sensitivity that they offer: the Experion RNA
StdSens analysis kit is used for the evaluation and quantitation of samples containing as 
little as 5 ng/µl RNA, and the Experion HighSens analysis kit is used for higher sensitivity 
evaluation of as little as 100 pg/µl RNA. Both kits use the following steps for RNA analysis:

1. Preparing the chip (priming and loading) –– Priming fills the microchannels of the
microfluidic chip with the GS, which contains both the sieving matrix and fluorescent
dye. RNA samples are then prepared and added to the sample wells along with the
loading buffer.

2. Vortexing the chip –– Vortexing ensures that samples and loading buffer are mixed.
Vortexing the chip itself reduces the number of sample manipulation and pipetting
steps required, improving reproducibility.

3. Running the chip –– The chip is inserted into the electrophoresis station and, as the
instrument lid is closed, the electrodes come in contact with the solution in the wells.
Voltage is applied to the sample wells of the chip, causing the charged RNA fragments
to migrate into the separation channel. In the separation channel, the RNA fragments
separate as they move at different rates through the gel matrix, depending on their
size. During separation, the fluorescent dye intercalates into the RNA strands.

4. Detecting the fragments –– As the fragments migrate towards the end of the separation
channel, a laser4 excites the dye, causing it to fluoresce if it is bound to RNA (excess,
free dye does not fluoresce appreciably). A photodiode detects the fluorescence, and
Experion software plots the fluorescence intensity versus time to produce an 
electropherogram and a virtual gel image.

5. Analyzing the data –– Following separation, Experion software subtracts background
noise, removes spikes, identifies and integrates peaks, and assigns their sizes and 
concentrations. Following analysis, parameters may be changed and the data reanalyzed.
The software also assigns 18S and 28S rRNA peaks based on their size and calculates
the total concentration of the sample by comparing the area under the sample 
electropherogram (excluding the lower marker) to the area under the ladder 
electropherogram.

4 635 nm excitation, 685 nm filter collection.
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How Experion Software Analyzes RNA

Data Presentation

As the photodiode detects fluorescent signals from the dye-RNA complexes, Experion 
software converts the signal into an electropherogram (a plot of fluorescence vs. time).
Experion RNA electropherograms differ depending on the type of sample analyzed 
(eukaryotic or prokaryotic total RNA or mRNA), but they generally have the following features:

Sample peak(s) –– signal(s) generated by the sample RNA fragment(s)

Lower marker (LM) –– signal generated by the internal lower (50 bp) marker, which is
included in the loading buffer and used to align the separations across all wells in the chip

Electropherogram generated by Experion RNA StdSens analysis of eukaryotic total RNA. Results
shown are typical for separations of total RNA from eukaryotic sources. The two most prominent peaks,
aside from the lower alignment marker, represent 18S and 28S ribosomal RNA (rRNA).
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Electropherogram generated by Experion RNA HighSens analysis of mRNA. For mRNA assays, the
sample peak is usually broad. Any 18S ribosomal RNA contamination is identified by the software.

Once separation occurs, these data are converted into a gel-like image, or virtual gel. Each
lane in the virtual gel corresponds to a different sample. The sample and lower markers
seen in the electropherogram also appear in the virtual gel.
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Virtual gel generated by Experion RNA StdSens analysis of eukaryotic total RNA (scaled to local).
Pink triangles indicate the positions of the lower marker.

When separation is complete, RNA fragments are identified as peaks in the electropherograms
and as bands in the virtual gel. The results of data analysis are also tabulated and presented
in a Results table at the end of analysis. The types of data available include the following:

• Concentration (in ng/µl or pg/µl, depending on the kit used)

• % rRNA contamination (mRNA analysis)

• 28S/18S (eukaryotic) or 23S/16S (prokaryotic) ratio (total RNA analysis)

• % of Total area 

Results table generated by RNA HighSens analysis of mRNA. Note that whereas the mRNA assay 
indicates rRNA contamination, the total RNA assay shows the ribosomal ratio, as shown in Fig. 1.9.
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Data Analysis: Normalization, Sizing, and Quantitation
Following separation, RNA fragments are analyzed using one or more of the following:

• An internal marker for normalizing the migration times of samples in different wells

• RNA ladder for determining fragment size (sizing) and concentration (quantitation) of
samples

Normalization: Aligning the Peaks
To compensate for small variations in samples or factors influencing separation (pH, dye
concentration, porosity of matrix, injection volumes, etc.), Experion RNA analysis uses an
internal marker to normalize the migration times between samples. The 50 bp lower marker
is included in the RNA loading buffer and, therefore, appears in all samples. Inclusion of this
marker and the normalization process ensures that the system software properly identifies
peaks. Once aligned, the software then further analyzes the data as described below.

Sizing
The first sample to be analyzed is the RNA ladder, which has been optimized for automated
electrophoresis on the Experion system. The RNA ladder contains eight purified 200–6,000 nt
RNA fragments. Experion software constructs a standard curve of migration time as a
function of size from the RNA ladder separation. It then calculates the size of the RNA
fragments from the sample wells by comparing their migration times to the standard curve.

Quantitation
Experion software begins RNA quantitation by comparing the time-corrected area (corrected
area) under the electropherogram of a sample (excluding the lower marker) with the corrected
area under the electropherogram of the RNA ladder. It then uses this value and the known
ladder concentration (160 ng/µl for the RNA StdSens assay, and 1,000 pg/µl for the RNA
HighSens assay) to determine the RNA concentration of the sample.
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Appendix B — Cleaning the Electrodes

Two types of cleaning procedures ensure the best results from the Experion™ electrophoresis
station: 1) a deep-cleaning procedure, which applies electrode cleaner directly to electrode
pins using swabs, and 2) a routine procedure, which uses cleaning chips and is performed
directly before and after every run.

Method 1: Deep Cleaning 
This manual procedure applies Experion electrode cleaner directly to the 16 platinum pins
in the electrode manifold. This method is the most stringent method of cleaning the
Experion electrode pins and helps to ensure RNase-free operation of the system. The need
for this deep cleaning will vary from lab to lab, depending on the frequency of use of the
Experion system and on the types of assays (protein, RNA, or DNA analysis) that are 
performed. Recognize that an Experion electrophoresis station used to analyze protein
samples will become contaminated with RNases and should be deep cleaned prior to any
RNA analysis.

Perform deep cleaning:

• Prior to first use of the Experion electrophoresis station

• Between a protein and an RNA analysis

• Any time when RNase contamination is suspected or any contamination (for example,
salt deposits or other precipitates) is visible on the electrodes 

• Whenever a chip has been left in the electrophoresis station for an extended period of
time (for example, overnight)

Perform this procedure with the electrode manifold in place (installed in the electrophoresis
station). It requires the following supplies, all of which are included in the Experion RNA
StdSens starter kit:

• Experion electrode cleaner 

• Experion DEPC-treated water 

• Foam swabs 

Warnings: Keep the chip platform completely dry during this procedure. Cover the chip
platform using plastic wrap and a paper towel to protect it from liquid.

1. Ensure that power to the electrophoresis station has been shut off.

2. Add 0.5–1 ml Experion electrode cleaner to a microcentrifuge tube. Insert a swab into
the solution until it is saturated with the electrode cleaner.

3. Use the swab to gently scrub each electrode pin one at a time, on all four sides. Do not
press too hard on the pins, as they may bend. Finally, clean the tip of each pin. Add
more electrode cleaner to the swab as necessary.

-Or-   

Move the swab up and down, and side to side, 2–3 times along the columns and rows
of pins. Finally, clean the tips of each of the pins. Add more electrode cleaner to the
swab as necessary.
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4. Repeat steps 2 and 3 twice, each time with a fresh swab soaked in DEPC-treated
water.

5. Fill a cleaning chip with 800 µl DEPC-treated water and place it in the electrophoresis
station for 1 min.

6. Remove the chip and allow the pins to dry completely by leaving the lid open for at
least 10 min.

Note: Refer to the Experion system instruction manual for more details and images.

Method 2: Routine Cleaning (RNA Analysis)
When performing RNA analyses, there are two types of routine cleaning procedures: one is
used before each run and involves use of Experion electrode cleaner and DEPC-treated
water (not required if a deep cleaning has just been performed), and the other is performed
after each run and involves a rinse using only DEPC-treated water.

Notes: Label the RNA cleaning chips when you begin: dedicate one for use with 
DEPC-treated water and the other for electrode cleaner.

If performing an RNA analysis after a protein analysis, perform the deep cleaning procedure
described above prior to RNA analysis.

Warning: Never store the cleaning chip inside the electrophoresis station. Store the empty
cleaning chip covered to keep the wells clean.

Preparing the Cleaning Chips

If the cleaning chips are being used for the first time, wash them with electrode cleaner to
remove any RNase contamination:

1. Fill the two cleaning chips with 800 µl Experion electrode cleaner. Let sit for 5 min.

2. Rinse the chips by treating with 800 µl DEPC-treated water for 1 min.

3. Repeat the DEPC-treated water rinse step 4 more times.

Method 2A: Cleaning Before an RNA Assay

Before each RNA analysis, clean the electrodes using both the Experion electrode cleaner
and DEPC-treated water (not required if a deep cleaning has just been performed):

1. Fill a cleaning chip with 800 µl Experion electrode cleaner. Gently tap the side of the
cleaning chip to remove any trapped bubbles from the wells. Label this chip “EC” to
indicate it contains the electrode cleaner.

Note: Experion electrode cleaner inactivates and removes RNases from the electrode, and
the water rinse removes traces of the cleaner from the electrodes to prevent it from affecting
the analysis.

2. Open the lid of the electrophoresis station and place the cleaning chip on the chip plat-
form.

3. Close the lid and leave it closed for 2 min.

4. Fill a second cleaning chip with 800 µl DEPC-treated water. Label this cleaning chip
“DEPC”.
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5. Open the lid and remove the cleaning chip labeled EC.

6. Insert the “DEPC” chip. Close the lid for 5 min. Remove the chip and discard the washes.

7. Replace the water in the “DEPC” chip and repeat steps 6.

8. Allow the electrodes to dry for 1 min.

9. Close the lid.

10. Replace the water in both cleaning chips after each use to avoid contamination. For
storage, remove the water from the cleaning chips and store the chips in a clean 
location.

Method 2B: Cleaning After an RNA Assay

Following each RNA analysis, rinse the electrodes with DEPC-treated water:

1. Fill the cleaning chip labeled “DEPC” with 800 µl DEPC-treated water. Gently tap the
side of the cleaning chip to remove any trapped bubbles from the wells.

2. Open the lid of the electrophoresis station and place the cleaning chip on the chip 
platform.

3. Close the lid and leave it closed for 1 min.

4. Open the lid and remove the cleaning chip.

5. Allow the electrodes to dry for 1 min.

6. Close the lid.

7. Replace the water in the cleaning chip after use to avoid contamination. For storage,
remove the water from the cleaning chip and store the chip in a clean location.
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Appendix C — First-Time Use of the Experion™

System
The first time that the Experion electrophoresis station is used, do the following:

1. Establish communication between the software and electrophoresis station.

a. Power on the computer.

b. Power on the Experion electrophoresis station by pushing the green button in the
center of the front panel. The steady green LED above the button indicates that
the unit is on.

c. Launch Experion software. Click the Experion software icon on the desktop or
select Start > All Programs > Bio-Rad Laboratories Experion > Experion. If a
prompt appears asking if Windows should block the program, click No.

The following indicate that communication has been established:

• A green dot with the last four digits of the instrument serial number in the lower
right corner of the main software screen

• An electrophoresis station icon in the upper left corner 

When there is no connection, these indicators are absent and a “disconnected” message
appears next to the Start Run button in the upper left corner of the screen. In 
addition, a grayed-out instrument icon appears in the upper left corner of the software
screen.

2. Confirm that all power saver and/or power options are turned off before starting the
assay (refer to the Experion system instruction manual for more details). Do not let the
computer “sleep” during a run.

3. Clean the electrode manifold using Experion electrode cleaner and the deep cleaning
procedure described in Appendix B.
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Appendix D — Ordering Information
Catalog # Description

700-7001 Experion™ System, 100/120 V, for RNA and DNA analysis, includes
electrophoresis station, priming station, vortex station, software, USB2
cable, instructions (analysis kits sold separately)

700-7002 Experion System, 220/240 V, for RNA and DNA analysis, includes 
electrophoresis station, priming station, vortex station, software, USB2
cable, instructions (analysis kits sold separately)

700-7111 Experion RNA StdSens Starter Kit, includes 3 Experion RNA StdSens
chips, 2 cleaning chips, Experion reagents, spin filters, total RNA standard,
cleaning swabs, electrode cleaner, tips and tubes to run 3 chips, instructions

700-7110 Experion Pro260 Starter Kit, includes 3 Experion Pro260 chips, 
1 cleaning chip, Experion reagents, spin filters, IgG protein standard, DTT,
cleaning swabs, electrode cleaner, tips and tubes to run 3 chips, instructions

700-7103 Experion RNA StdSens Analysis Kit for 10 Chips, includes 10 RNA
StdSens chips, 1,250 µl RNA gel, 20 µl RNA StdSens stain, 20 µl RNA ladder,
900 µl RNA StdSens Loading buffer, 2 spin filters

700-7105 Experion RNA HighSens Analysis Kit for 10 Chips, includes 10 RNA
HighSens chips, 1,250 µl RNA gel, 20 µl RNA HighSens stain, 20 µl RNA
ladder, 900 µl RNA HighSens loading buffer, 2 spin filters

700-7153 Experion RNA StdSens Chips, 10

700-7154 Experion RNA StdSens Reagents and Supplies, for 10 chips, includes 
1,250 µl RNA gel, 20 µl RNA StdSens stain, 20 µl RNA ladder, 900 µl RNA
StdSens Loading buffer, 2 spin filters

700-7255 RNA Ladder, 20 µl

700-7251 Experion Cleaning Chips, 10

700-7254 Experion Spin Filters, 10

700-7252 Experion Electrode Cleaner, 250 ml

700-7253 Experion DEPC-Treated Water, 100 ml

700-7264 Swabs, 25

VWR87001-688 VWR barrier pipet tips, sterile (narrow-bore, 20 µl universal pipet tips,
RNase-free) (Purchase directly from VWR Scientific Products)

5395 Experion Training Video: Chip Loading (DVD) (also available at 
discover.bio-rad.com/Experion/)

10000976 Experion RNA StdSens Instruction Manual

10001312 Experion System Instruction Manual
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